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Введение 
В настоящее время имеется обширная литература по теории и методам синтеза раз-

личных типов фильтров СВЧ. Разработанные методы синтеза многих структур фильтров 
СВЧ (например, на основе фильтров-прототипов нижних частот, ступенчатых трансформа-
торов, использования частотного преобразования Ричардса) позволяют синтезировать 
фильтры с высокой точностью на уровне электрических параметров (волновые сопротивле-
ния, электрические длины). Однако при переходе от электрических параметров фильтра к 
геометрическим параметрам топологии возникают определённые трудности, связанные с не-
достаточной точностью существующих моделей отрезков линий передач и различных неод-
нородностей, а также с проблемами учёта дисперсии, влияния корпуса, проводимости мате-
риала проводников и т.п., особенно в верхней части СВЧ диапазона. Это приводит к необхо-
димости экспериментальной отработки топологии на макетах фильтров. 

С появлением программных продуктов, позволяющих выполнять анализ топологии 
устройств СВЧ на электродинамическом уровне, ситуация изменилась. Появилась возмож-
ность так смоделировать топологию проектируемого фильтра, чтобы экспериментальная ха-
рактеристика хорошо совпадала с расчётной. 

Одним из популярных программных продуктов, используемых для проектирования 
микрополосковых устройств СВЧ, является Microwave Office компании Applied Wave Re-
search (AWR). Проектирование СВЧ фильтров в этом программном продукте в общем случае 
можно разделить на три этапа: 

• Выбор структуры фильтра в первом приближении. 
• Уточнение параметров выбранной структуры в линейном моделировании. 
• Окончательная доводка параметров топологии в электромагнитном моделировании. 

Поскольку Microwave Office является программой анализа, для начала работы в ней 
необходимо предварительно выбрать структуру фильтра и определить её параметры хотя бы 
в достаточно грубом приближении. Для некоторых структур фильтров, например, фильтров 
на четвертьволновых шлейфах, это сделать достаточно просто. Но для большинства структур 
(фильтров с боковыми электромагнитными связями, встречноштыревых и др.) необходимо 
сделать какие-то предварительные расчёты. Для некоторых типов фильтров можно исполь-
зовать встроенный в Microwave Office мастер синтеза фильтров (Filter Synthesis Wizard) или 
интегрированный модуль NuHertz Filter. 

После выбора структуры фильтра создаётся электрическая схема фильтра с учётом 
неоднородностей и выполняется анализ созданной схемы. Затем изменяются параметры эле-
ментов схемы до получения требуемой характеристики. Для этого можно использовать оп-
тимизацию схемы. Если полученная первоначально характеристика далека от требуемой, оп-
тимизация может не сработать. В этом случае лучше использовать инструмент ручной на-
стройки схемы, который сделан очень удобным и работает в режиме реального времени. 

Когда требуемая характеристика получена, создаётся электромагнитная структура то-
пологии фильтра с учётом реальных размеров корпуса и материалов диэлектрика и провод-
ников. Полученные в линейном моделировании размеры топологии округляются так, чтобы 
они были кратными выбранным размерам клеток сетки электромагнитной структуры. Вы-
полняется анализ созданной электромагнитной структуры. Полученная характеристика мо-
жет довольно существенно отличаться от характеристики, полученной в линейном модели-
ровании. 

После этого делаются изменения (подбор) размеров топологии и выполняется анализ 
после каждого изменения до тех пор, пока будет получена требуемая характеристика фильт-
ра. Не всегда очевидно, какие параметры топологии нужно изменять и в какую сторону, что-
бы приблизить полученную характеристику к требуемой. Если необходимо сдвинуть харак-
теристику по частоте, ясно, что нужно изменить резонансную частоту резонаторов (т.е. их 
длину). Чтобы изменить ширину полосы пропускания, необходимо изменить величину свя-
зей между резонаторами (например, величину зазоров в фильтрах с электромагнитной свя-
зью). Обычно, чем ближе характеристика к желаемой, тем сложнее определить, что нужно 



изменить в топологии, чтобы правильно подобрать соотношения между резонансными час-
тотами отдельных резонаторов, связями между ними и волновыми сопротивлениями. Эта 
процедура кропотливого подбора размеров топологии является наиболее трудоёмкой и дли-
тельной. Анализ электромагнитной структуры может занимать значительное время. Для ус-
корения процедуры электромагнитного моделирования можно рекомендовать вначале вы-
полнять анализ с относительно крупной сеткой и меньшим числом частотных точек. Затем 
увеличить количество клеток в сетке, уменьшив их размер, и увеличить число частот. При 
окончательной доводке топологии можно перейти от графика вносимого ослабления к гра-
фику коэффициента стоячей волны, который более чувствителен к изменениям параметров 
топологии. Затраченные усилия на кропотливый подбор размеров топологии окупается вы-
сокой точностью моделирования, при которой отпадает необходимость в экспериментальной 
отработке или она сводится к минимуму. 

Следует иметь в виду, что высокая точность электромагнитного моделирования обес-
печивается при условии, когда проводники топологии параллельны сетке разбиения, а раз-
меры топологических форм кратны размерам клеток сетки. Структуры типа, показанной на 
рис. 1, когда проводники расположены под углом к сетке, для получения точных результатов 
анализа требуют очень мелкой сетки. Это может привести к такому увеличению времени 

анализа, что оно становится непри-
емлемым. В таком случае подобные 
структуры лучше моделировать в 
программных продуктах с более гиб-
кой сеткой, например, в IE3D компа-

нии Zeland или CST Microwave Studio компании Computer Simulation Technology. 
Для широкополосных фильтров, если они спроектированы с запасом по ширине поло-

сы пропускания и крутизне скатов, обычно настройка не требуется. Узкополосные фильтры 
гораздо более чувствительны к технологическим разбросам и требуют настройки. При этом 
сдвинуть характеристику фильтра вверх по частоте сложнее, т.к. это требует укорочения 
(подрезки) резонаторов. Проще сдвинуть характеристику вниз по частоте, т.к. это можно 
сделать, например, приклеиванием узкой пластины из того же материала подложки, накла-
дываемой на все резонаторы фильтра. Поэтому узкополосные фильтры лучше проектировать 
заведомо выше требуемой полосы пропускания. Кроме того, должен быть предусмотрен за-
пас по ширине полосы пропускания. Регулировать ширину полосы пропускания характери-
стики можно, изменяя высоту от подложки до верхней крышки корпуса. При уменьшении 
этой высоты полоса пропускания уменьшается (обычно больше сдвигается в область верхних 
частот нижний скат характеристики фильтра). Однако этот метод не удобен для практиче-
ского применения. Оценить возможный разброс характеристики можно, выполнив статисти-
ческий анализ, имеющийся в линейном моделировании Microwave Office. 

Наиболее распро-
странённым материалом для 
подложек микрополосковых 
фильтров является поликор. 
Это анизотропный материал. 
Однако в Microwave Office 
не предусмотрено примене-
ние анизотропных материа-
лов. Поэтому в приводимых 
примерах проектирования 
фильтров на поликоре ис-
пользуются значения ди-
электрической проницаемо-
сти из графика (рис. 2), по-
лученного эксперименталь-
ным путём. Эти значения 
нельзя считать абсолютно 

Рис. 1 

Рис. 2 
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Чтобы продемонстрировать второй способ создания электромагнитной структуры 
фильтра мы не будем создавать новой структуры. Выделите все элементы топологии, 
например, выбрав в меню команду Edit>Select All, и удалите их, нажав клавишу Delete. 
Теперь начертим топологию непосредственно в окне редактора электромагнитной 
структуры, используя значения параметров элементов схемы. Чертить также можно 
различными способами. Можно, например, начертить сразу всю топологию, используя 
инструмент Polygon Conductor. Или можно чертить отдельными прямоугольниками. При 
этом начерченная топология не обязательно должна абсолютно точно совпадать с 
полученной ранее. 

Проводники топологии чертятся точно по сетке. Поэтому удобнее, если сетка видна. 
Если сетка мелкая и её не видно, щёлкните по значку View Area на панели инструментов или 
выберите в меню команду View>View Area и выделите тот участок электромагнитной 

структуры, на котором будет выполняться черчение. 
1. Выберите в меню команду Draw>Add Rect Conductor или 

щёлкните по значку Rectangle Conductor  на панели 
инструментов. Поместите курсор в окно электромагнитной 
структуры и нажмите клавишу Tab. В открывшемся окне 
Enter Coordinates (Ввод координат) в поле x введите 0, а 
поле y введите 1.3 (рис. 1.35). Нажмите OK. Нажмите 
клавишу Tab снова. В новом открывшемся окне в поле dx 
введите длину входного проводника 3, а в поле dy введите 
ширину проводника 0.45 (рис. 1.36) и нажмите OK. 
Входной прямоугольный проводник отобразится на 

электромагнитной структуре (рис. 1.37). 

Рис. 1. 35 

Рис. 1.36 

2. Если пользоваться координатным вводом не очень 
удобно, можно использовать инструмент для 
создания многоугольников. Выберите в меню 
команду Draw> Add Conductor или щёлкните по 
значку Polygon Conductor  на панели 
инструментов. Поместите курсор на правую 
сторону входного проводника на 0,05 мм ниже 

правого верхнего угла (т.е. на одну 
клетку сетки) и щёлкните левой 
кнопкой мышки, чтобы закрепить эту 
точку. Переместите курсор вправо на 
dx: 5.15 (смещение отображается рядом 
с курсором) и снова щёлкните мышкой. 
Если топология выходит за пределы 
окна и при этом курсор выходит за 

границу рабочего поля, можно использовать клавиши перемещения курсора для 
скроллинга отображаемой топологии, не отпуская кнопки мышки. Переместите 

курсор вниз на dy: 0.35 и снова 
щёлкните мышкой. Переместите курсор 
влево на dx: -5.15 и дважды щёлкните 
мышкой, чтобы замкнуть 
прямоугольник. Альтернативно, можно 
щёлкнуть один раз, переместить курсор 

на dy: -0.35 вверх и снова щёлкнуть мышкой. Полученная топология показана на 
рис. 1.38. 

Рис. 1.37 

Рис. 1



4. Щёлкните по значку Polygon Conductor на панели инструментов. Поместите курсор 
на левый нижний угол второго проводника и щёлкните левой кнопкой мышки. Пе-

реместите курсор вправо на dx: 
0.35 и щёлкните мышкой. Пере-
местите курсор вниз на dy: 1.85 и 
щёлкните мышкой. Переместите 
курсор влево на dx: -0.35 и дваж-
ды щёлкните мышкой. Получен-
ная топология с первым шлейфом 
показана на рис. 1.40. 
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а по значку Paste. Поместите скопированный прямоугольник в конце среднего 

шки по любому элементу 

топологии можно, используя инструмент Measure, 

1.1.11. Установка портов и анализ электромагнитной структуры. 
Выберите в 

5. Щёлкните по последнему создан-
ному прямоугольнику, чтобы его 
выделить (если он не выделен). 

Щёлкните по значку Copy на панели инструментов и затем по значку Paste. Помес-
тите скопированный прямоугольник примерно посредине среднего проводника так, 
чтобы его верхняя сторона касалась нижней стороны среднего проводника, и щёлк-
ните мышкой. Измерьте расстояние между шлейфами. Для этого щёлкните по знач-
ку Measure (Измерение) на панели инструментов или щёлкните правой кнопкой 
мышки в любом месте рабочего поля и выберите команду Measure. Поместите кур-
сор на верхний правый угол первого шлейфа, нажмите левую кнопку мышки и, не 
отпуская кнопки, переместите курсор на верхний левый угол второго шлейфа и за-
метьте расстояние между шлейфами. Допустим, это расстояние оказалось равным 
2,3 мм. Поместите курсор на второй шлейф, нажмите левую кнопку мышки и, не от-
пуская кнопки, переместите шлейф влево на dx: -0.4, чтобы расстояние между 
шлейфами было равно 1,9 мм. Дважды щёлкните по второму шлейфу. Поместите 
курсор на ромбик посередине правой стороны шлейфа так, чтобы он отображался в 
виде двойной стрелки. Нажмите левую кнопку мышки и, не отпуская кнопки, пере-

местите правую сторону 
шлейфа вправо на dx: 0.3, 
чтобы ширина шлейфа была 
равна 0,65 мм. Поместите 
курсор на ромбик посередине 
нижней стороны шлейфа так, 
чтобы он отображался в виде 
двойной стрелки. Нажмите 
левую кнопку мышки и, не 
отпуская кнопки, переместите 
нижнюю сторону шлейфа 
вверх на dy: -0.35, чтобы дли-
на шлейфа была равна 1,5 мм. 

6. Снов

Рис. 1.40 

Рис. 1.41 

проводника. Полученная топология показана на рис. 1.41. 
7. Выделите всю топологию, Щёлкните правой кнопкой мы

топологии и выберите Mesh/Material Properties. В открывшемся окне выберите ма-
териал 1/2oz Cu и нажмите OK. 

Проверить правильность размеров 
как указывалось выше. 

1. Щёлкните по входному проводнику топологии, чтобы выделить его. 
меню команду Draw>Add Edge Port или щёлкните по значку Edge Port (Порт гра-
ни), поместите курсор на левую сторону входного проводника так, чтобы на ней 
появился небольшой прямоугольник, и щёлкните мышкой. 
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ите по выходному про-

й 

2. Теперь нужно установить референсную плоскость на некотором расстоянии от ле-
вого края корпуса. Это расстояние должно быть таким, чтобы возникшие на левом 

краю высшие типы волн за-
тухли к референсной плоско-
сти. Обычно это расстояние 
рекомендуют не менее толщи-
ны подложки. Щёлкните левой 
кнопкой мышки по прямо-
угольнику порта. Установите 
курсор на правую сторону это-
го прямоугольника так, чтобы 
курсор отображался в виде 
двойной стрелки. Нажмите ле-
вую кнопку мышки и перемес-

тите курсор вправо на dx: 1. 
3. Щёлкн

Рис. 1.42 

воднику топологии и аналогично 
установите второй порт, сдвинув 
референсную плоскость на 1 мм 
влево. Окончательная топология 
фильтра показана на рис. 1.42. 

4. Щёлкните правой кнопко
мышки по имени электромаг-
нитной структуры (FZ) в левом 
окне проекта и выберите коман-
ду Options. В появившемся окне 
Options отройте вкладку Fre-
quencies (Частоты). В этом окне 
(рис. 1.43) для каждой электро-

магнитной структуры можно установить свои частоты для анализа, отличные от 
частот проекта. Это бывает полезно, если частот для анализа в проекте много и вре-
мя электродинамического анализа слишком большое. Чтобы установить частоты 
только для данной структуры, нужно снять “галочку” в Use project defaults (Ис-
пользовать значения проекта по умолчанию) и затем ввести значения частот обыч-
ным образом. Мы для анализа будем использовать частоты проекта, поэтому эта 
“галочка” должна быть установлена. 

Рис. 1.43 

5. Дважды щёлкните левой кнопкой мышки по имени графика (LdB) в левом окне 
проекта, чтобы сделать окно графика активным. Выберите в меню команду 
Simulate>Analyze или щёлкните по значку Analyze  на панели инструментов. 
Анализ начнёт выполняться и откроется окно, в котором отображается процесс ана-

Рис. 1.44 Рис. 1.45. 



лиза (рис. 1.44). Щёлкнув по кнопке Cancel в этом окне, выполнение анализа можно 
остановить в любое время. Полученная характеристика показана на рис. 1.45. Как 
видно из графиков, эта характеристика заметно отличается в полосе заграждения от 
полученной в линейном моделировании и не удовлетворяет заданным требованиям. 

1.1.12. Редактирование электромагнитной структуры. 
На этом этапе необходимо подобрать такие размеры 

топологии, чтобы характеристика фильтра удовлетворяла 
предъявляемым требованиям. Чтобы удобнее было вер-
нуться к предыдущему варианту в случае неудачной по-
пытки, обычно лучше сделать копию электромагнитной 
структуры и редактировать её. 

1. Установите курсор на подгруппу электромагнит-
ной структуры FZ в левом окне проекта, нажмите 
левую кнопку мышки и, не отпуская кнопки, пе-
реместите курсор на группу EM Structures, от-
пустите кнопку. В группе EM Structures появит-

ся подгруппа Copy of FZ (рис.1.46), а на рабочем поле откроется окно созданной 
копии нашей структуры. 

Рис. 1.46 

2. Полученную копию структуры мож-
но переименовать. Щёлкните правой 
кнопкой мышки по подгруппе Copy 
of FZ и выберите Rename EM Struc-
ture. В открывшемся окне в поле 
New name введите новое имя скопи-
рованной структуры, например, FZ1 
и нажмите OK. 

Начнём редактирование скопирован-
ной структуры с изменения размеров среднего 
шлейфа.  Рис. 1.47

1. Дважды щёлкните по среднему шлейфу, установите курсор на синий ромбик посре-
дине нижней стороны шлейфа так, чтобы курсор отображался в виде двойной 
стрелки. Нажмите левую кнопку мышки и, не отпуская кнопки, переместите курсор 
вверх на величину dy:-0.1 (рис. 1.47), отпустите кнопку. 

2. Дважды щёлкните по имени графика в левом окне проекта, чтобы сделать активным 
окно графика. 

Рис. 1.49 
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3. Щёлкните по значку Analyze  на панели инструментов, чтобы выполнить анализ 
структуры с укороченным шлейфом. Полученный график показан на рис. 1.48. Как 

Рис. 1.48



видно, новая характеристика ближе к требуемой, поэтому продолжим укорочение 
среднего шлейфа. 

4. Сначала удалите структуру FZ, имеющую худшую характеристику. Для этого 
щёлкните правой кнопкой мышки по под-
группе FZ в левом окне проекта и выберите 
Delete EM Structure. Затем создайте копию 
структуры FZ1, как описано выше. Этой ко-
пии можно присвоить прежнее имя FZ. 

5. В новой структуре FZ дважды щёлкните по 
среднему шлейфу и снова укоротите его на 

0.1, как описано выше на шаге 1. 
Рис. 1.50 

6. Выполните анализ новой структуры. Полученный график показан на рис. 1.49. По-
лученная характеристика ближе к требуемой, но не удовлетворяет требованию на 

частоте 18 ГГц. 
7. Удалите предыдущую структуру FZ1 и сде-

лайте копию последней структуры FZ, её 
можно снова переименовать в FZ1. Умень-
шите ширину микрополоски, с которой со-
единены шлейфы на 0,1 мм. Для этого два-
жды щёлкните по этой микрополоске. Уста-
новите курсор на синий ромбик посредине 

верхней стороны этой микрополоски и сместите её вниз на 0.05. Затем поместите 

курсор на синий ромбик посредине нижней стороны и сместите её вверх на 0.05 
(рис. 1.50). Установите курсор на первый шлейф, нажмите левую кнопку мышки и, 
не отпуская кнопки, сдвиньте шлейф вверх так, чтобы он соединился с микрополос-
кой. Аналогично соедините второй и третий шлейфы с микрополоской (рис. 1.51). 
Выполните анализ полученной структуры. График показан на рис. 1.52. Получен-
ный график уже близок к требуемому, но немного сдвинут вверх по частоте. 

Рис. 1.51 

Рис. 1.52 Рис. 1.53 

8. Удалите предыдущую структуру FZ и сделайте копию последней структуры FZ1, её 
можно снова переименовать в FZ. Дважды щёлкните по первому шлейфу в новой 
структуре, установите курсор на ромбик посредине нижней стороны этого шлейфа и 
сместите эту сторону вниз на 0.05. Аналогично удлините на 0.05 третий шлейф. Вы-
полните анализ новой структуры. Полученная характеристика показана на рис. 1.53. 
Эта характеристика несколько уже по полосе заграждения и не удовлетворяет тре-
бованиям на верхней частоте 18 ГГц. 

9. Удалите предыдущую структуру FZ1 и сделайте копию последней структуры FZ, её 
можно снова переименовать в FZ1. Дважды щёлкните по микрополоске, с которой 
соединены шлейфы, установите курсор на ромбик посредине верхней стороны и 
сместите её вниз на 0.05. Выполните анализ этой структуры. Полученная характери-
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ная в результате электромагнитного моделирования топология фильтра пока-
зана н

итными связями, обеспе-
чиваю

1.2.1. Создание электрической схемы. 
 именем FZ4. 

енем FilZ. 
дважды щёлкнув 

нт 

кните по подгруп-

стика (рис. 1.54) удовлетворяет поставленным требованиям. Чтобы не затемнять 
график, можно щёлкнуть правой кнопкой мышки в группе графика LdB по имени 

кривой All Sources:DB(|S(2,1)|) в левом 
окне проекта и выбрать Properties. В 
открывшемся окне в поле Data Source 
Name (см. рис. 1.10) введите имя по-
следней электромагнитной структуры 
FZ1, щёлкнув по кнопке в правом кон-
це этого поля, и нажмите OK. Или 
можно просто удалить схему (Sche-
matic 1) и предыдущую электромагнит-
ную структуру (FZ) из проекта. Харак-

теристика последнего варианта электромагнитной структуры показана на рис. 1.55. 
Получен

Рис. 1.54 Рис. 1.55 

Рис. 1.56 

а рис. 1.56. Как видно, размеры элементов топологии несколько отличаются от соот-
ветствующих размеров, полученных в линейном моделировании. 

1.2. Фильтр с частотой заграждения 4 ГГц 
Требуется спроектировать фильтр с боковыми электромагн
щий ослабление на частоте 4 ГГц не менее 50 дБ. 

1. Создайте новый проект и сохраните его под
2. Щёлкните по значку New Schematic и создайте схему с им
3. Откройте в левом окне вкладку Elem. Раскройте группу Microstrip, 
по ней мышкой или щёлкнув по значку “+” слева от этой группы. Затем щёлкните по 

подгруппе Lines. 
4. В нижней части левого окна выберите элеме

MLIN и перетащите его в окно схемы. Затем в верх-
ней части левого окна щёлкните по подгруппе Cou-
pled Lines (Связанные линии), в нижней части левого 
окна найдите элемент MCLIN, перетащите его в окно 
схемы и соедините с правым концом элемента MLIN, 
как показано на рис. 1.57. 

5. В верхней части левого окна щёл
Рис. 1.57 

пе Bends (Изгибы). Найдите элемент MBENDA$ и подключите его к узлу 4 элемента 
MCLIN. 

6. В верхней части левого окна щёлкните по подгруппе Lines, выберите элемент MLIN, 
перетащите его в окно схемы, три раза щёлкните правой кнопкой мышки, чтобы раз-
вернуть элемент на 270 градусов и подключите его к элементу MBENDA$. 




